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Safety and Regulatory Compliance

Important Safety Information

Please read these instructions before attempting to operate the GS-900™ 

calibrated densitometer.

This instrument is suitable for research use only. It must be used, therefore, only by 

specialized personnel who know the health risks associated with the reagents that 

are normally used with this instrument. 

Warranty

The GS-900™ calibrated densitometer is warranted against defects in materials and 

workmanship for one year. If any defect occurs in the instrument during this 

warranty period, Bio-Rad Laboratories, Inc. will repair or replace the defective parts 

at its discretion without charge. The following defects, however, are specifically 

excluded:

 Defects caused by improper operation

 Repair or modification done by anyone other than Bio-Rad Laboratories, 

Inc. or the company’s authorized agent

 Use of spare parts supplied by anyone other than Bio-Rad Laboratories, 

Inc.

 Damage caused by accident or misuse

 Damage caused by disaster

 Corrosion caused by improper solvents or samples
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General Precautions

 Read the user guide carefully.

 The instrument must be used only for the intended purpose of gel 

documentation in research laboratories.

 The instrument must be connected to a grounded power source line and 

protected by a circuit breaker.

 Do not pour liquids directly on or inside the instrument.

 Switch off all lights on the instrument immediately after use.

 Clean the transilluminator sample area after use.

Regulatory Notices

The GS-900 densitometer is designed and certified to meet EN 61010-1, the 

internationally accepted electrical safety standard, EMC regulations, and TUV 

requirements. Certified products are safe to use when operated in accordance with 

this user guide. Do not modify or alter this instrument in any way. Modification or 

alteration of this instrument will

 Void the manufacturer’s warranty

 Void the regulatory certifications

 Create a potential safety hazard
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Alert Icons

Alert icons call attention to caution and warning paragraphs in this guide. The icon 

indicates the type of hazard addressed.

Cautions

A caution alerts you to take or avoid a specific action that could result in loss of data 

or damage to the instrument. A caution can also indicate that, if the precaution 

against a potential hazard is not taken, minor or moderate injury might occur. 

Example

Caution:  With the exception of cleaning or replacing light bulbs, refer all 

servicing to qualified Bio-Rad personnel or their agents.

Table 1. How alert icons are used in this guide 

Icon Explanation

General

Indicates a potential hazard requiring special attention. This icon appears 

when the hazard or condition is of a general nature.

Electrical hazard

Indicates a potential hazard requiring special attention when you are working 

with electricity or electrical equipment.

Extreme heat and flammable materials

Indicates a potential hazard requiring special attention when you are working 

with extreme heat and flammable materials.

Radiation hazard

Indicates a potential hazard requiring special attention when you are working 

with UV radiation.
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Warnings

A warning precedes an action that, if not followed correctly, could cause serious 

injury or death to the operator, serious or total loss of data, or serious damage to the 

instrument.

Example

WARNING!  This instrument must be connected to an appropriate AC voltage 

outlet that is properly grounded.

Instrument Safety Warnings

Before you operate the instrument, carefully read the contents of Table 2.

Table 2. Safety cautions and warnings for the instrument

Icon Meaning

Caution: With the exception of cleaning or replacing light bulbs, 

refer all servicing to qualified Bio-Rad personnel or their agents. If 

you experience technical difficulties with the instrument, contact 

Bio-Rad to schedule service. The instrument should not be modified 

or altered in any way. Alteration voids the manufacturer’s warranty 

and might create a potential safety hazard for the user.

WARNING!  This instrument must be connected to an appropriate 

AC voltage outlet that is properly grounded.

Note: This Bio-Rad product is designed and certified to meet  

EN 61010-1 safety standards. Certified products are safe to use 

when operated in accordance with the instrument guide. This 

instrument should not be modified or altered in any way. Alteration 

of this instrument will void the warranty, void the EN 61010-1 

certification, and create a potential safety hazard. This safety 

certification does not extend to other equipment or accessories not 

EN61010-1 certified, even when connected to this product.
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Notice

The GS-900™ densitometer is intended for laboratory use only. This device is 

meant for use by specialized personnel who know the health risks associated with 

reagents normally used in electrophoresis. Bio-Rad Laboratories, Inc. is not 

responsible for any injury or damage caused by use of this instrument for purposes 

other than those for which it is intended, or for instrument modifications not 

performed by Bio-Rad Laboratories, Inc. or an authorized agent.
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1 Introduction

The GS-900™ calibrated densitometer acquires images of transparent and opaque 

electrophoretic samples. The GS-900 calibrates to an internal National Institutes of 

Standards and Technology (NIST)-traceable reference standard for optimal 

accuracy and reproducibility.

With Image Lab™ software, you control the instrument, analyze the resulting image, 

and produce a report in a format you choose.

Note: The GS-900 calibrated densitometer is supported with Image Lab 

running on a computer using the Microsoft Windows operating system only.

Main Features of the GS-900 Calibrated Densitometer

 Transmissive and reflective scanning modes

 Wide dynamic range: 

 Transmissive: 0.0–3.4 OD (specular)

 Reflective: 0.0–2.7 OD (specular)

 Calibration to internal reference standards (NIST-traceable for transmissive 

scans)

 User-selectable scanning resolution from 36.3 to 127.2 m

 Image acquisition with 16-bit depth

 Scanning area of 29 x 33 cm for positioning of large or multiple samples
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Measurement of Optical Density

The GS-900 calibrated densitometer uses internal calibration standards to ensure 

accurate optical density measurements of scanned samples. The internal 

calibration standards consist of either a piece of photographic film (for transmissive 

scans) or a piece of photographic paper (for reflective scans) that have been 

exposed in order to generate several areas, or steps, with different optical densities. 

The optical densities of these steps are accurately measured before being installed 

into the instrument, and the instrument is preprogrammed with these values. 

Prior to each scan of a sample, the appropriate calibration standard is scanned and 

the light intensity levels for each step of the standard are used to correlate the 

sample detected light intensity to a known optical density found on the calibration 

standard. This allows light intensity levels measured on the sample area to be 

correlated to a known optical density value and ensures accurate and reproducible 

optical density measurements of scanned samples.

During manufacture, the internal calibration standard is measured using an 

instrument capable of diffuse density measurements. However, the internal 

calibration standard diffuses light differently than protein bands on a Coomassie 

stained gel. Additionally, the light collection angles of the optics in the GS-900 make 

it unsuitable for diffuse density measurements. For these reasons, specular density 

measurements are more appropriate for Coomassie stained gels that are imaged 

with the densitometer, and Image Lab reports specular density values only. 



Technical Specifications

Instrument Guide  |  13

Technical Specifications

Transparent  Polyacrylamide gels

 Film

Reflective Blotting membranes

Supported file types  Import: .scn, .1sc

 Export: .tif, .jpg, .bmp, .png

Image sensor type Tri-linear CCD with three filters (red, green, blue)

Resolution  Spot size (m): 36.3, 42.3, 63.5, 95.3, 127.0

Light source LED

Scanning area  Transparent: 29.0 x 33.0 cm

 Reflective: 29.0 x 33.0 cm

Dynamic range  Transmissive: 0.0–3.4 OD (specular)

 Reflective: 0.0–2.7 OD (specular)

Bit depth  Input: 16-bit gray scale

 Output: 16-bit gray scale

Calibration  Transmissive: To internal NIST-traceable transmissive 

reference standard

 Reflective: To internal reflective reference standard

Connectivity USB 2.0

Operating voltage 100–240 V AC, 47–63 Hz

Power consumption 54.0 watts

Operating temperature 10–28°C

Operating humidity <70% noncondensing

Dimensions  Length: 63 cm

 Height: 19 cm

 Width: 38 cm

Weight 16 kg (35.4 lbs)

Scannable Sample Types

Software Specifications

Hardware Specifications
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2 Setting Up the Imager

Calibrating the GS-900 Densitometer

Before you can use Image LabTM with the GS-900™ densitometer, Image Lab must 

calibrate and acquire the flat images. 

Note: It can take up to 30 minutes to acquire a flat image. 

When you first connect the instrument to the computer running Image Lab, the 

software prompts you to begin calibration.

After the densitometer has been in use for some time, it might require recalibration 

for one of the following reasons:

 Scheduled recalibration according to your institution’s procedures

 Presence of visible artifacts such as a non-uniform background or streaks

To prepare the densitometer for initial calibration

1. Ensure that the following surfaces are clean and free of scratches:

 Sample area

 Calibration area (the narrow band of glass near the sample area)

 Glass on the transmission module

2. Close the densitometer lid and turn on the densitometer.

3. Connect the densitometer to the computer running Image Lab.
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To calibrate the densitometer

1. Start Image Lab.

The Instrument Calibration dialog box appears. It identifies the instrument to 

which your computer is connected.

2. Click Next.

The Calibrate GS-900 Standards Location screen appears.
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3. Click Calibrate GS-900 Standards Location.

A dialog box monitors the progress of the calibration. When the standards 

location is calibrated, the Acquire Flat Image dialog box appears. 

4. Click Acquire Flat Image.

A progress indicator monitors  the acquisition. After the instrument acquires the 

flat image, the Setup Summary dialog box appears.

By default, the Go to default protocol setup after instrument setup checkbox is 

selected. 

5. If you do not want to set up a default protocol now, clear the checkbox and 

click Finish. You can set up the default protocol later. See Chapter 3, Acquiring 

Images for instructions.
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3 Acquiring Images

Image Lab software runs configurable application-based protocols for sample 

imaging. In a single acquisition, a protocol runs a combination of settings for 

acquiring an image, analyzing it, and creating a customized report. 

An image Lab protocol defines an application, its scan options, and analysis and 

reporting functions. You can run a default protocol by pressing the green Run button 

on the densitometer. The densitometer acquires the image using the default 

protocol application and settings. You can create a default protocol for the set of 

acquisition settings you use most often.

Protocols can be retrieved, revised, and reused. You can also save protocols with 

different settings and run them in Image Lab software. 

Note: Images you scan at high resolution result in large files. For this reason, 

Bio-Rad recommends archiving images by exporting the files to a network file 

server or to removable storage media.

For more detailed information about protocols, see the Image Lab Software User 

Guide.
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Creating a Protocol

Creating a protocol consists of configuring acquisition, analysis, and output 

settings. Analysis and output settings are optional.

To create a protocol, you configure these settings on the Protocol Setup screens. 

The title bar above the Protocol Setup screen displays the protocol name and 

imager type.Main steps appear as headings in the left pane of each screen. 

Numbered steps appear under these headings.

Analysis settings consist of the following:

 Detecting lanes and bands

 Analyzing molecular weight

Output settings consist of the following:

 Printing the image

 Printing the report

 Displaying the report
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To choose options for a protocol step, select the checkbox to the left of the 

numbered step. To disable a numbered step, clear its checkbox.

Options for the selected step appear on the right side of the screen. 

Accessing Protocol Setup Screens

To access the default Protocol Setup screen

1. Verify that the name of your imager appears on the status bar.

A green check mark next to the imager name indicates that the imager is 

connected to the computer running Image Lab software and is communicating 

with Image Lab.

2. Click Default Protocols on the toolbar.

3. The Default Protocol Setup dialog box appears.Click Create.

The Default Protocol Setup screen appears. 

To access the Protocol Setup screen for any other protocol

1. Verify that GS-900 appears on the status bar.

2. Click New Protocol on the toolbar. 
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The Protocol Setup screen appears with Gel Imaging selected. Acquisition 

options appear in the right pane.

The Protocol Setup screen appears. Gel Imaging is selected in the left pane.

Gel imaging options appear on the right side of the Protocol Setup screen. The 

protocol name appears in the title bar. You can change this name when you 

save the protocol. 

Choosing an Application

The term application refers to sample type. The sample types consist of the 

following options:

 Nucleic acid gel, protein gel, or blot 

 Detection reagent — dye or stain

In the Gel Imaging Protocol Setup screen, you can choose from a list of predefined 

applications for common sample types. Each sample type is predefined with 

optimal acquisition settings.

Note: To use a dye or stain not listed in the Application dropdown menus, you 

can choose the application type Custom and create a custom application. For 

more information, see Setting Up a Custom Application in this chapter. 
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To configure the acquisition settings 

1. Under Applications, click Select and choose an application on the menu that 

appears

2. Under Resolution, click Change to set the resolution value.

Tip:  Resolution is a measure of pixel size in microns. The default 

resolution value of 63.5 microns usually provides sufficient resolution to 

obtain a good quality image. Decreasing the resolution value increases the 

number of pixels scanned, which increases the resolution. Increasing the 

resolution also increases the scan time and the file size.

3. Under Scan Area, select the gel type you want to scan.

When you select a gel type, the values in the scan area automatically change to 

match the size of the selected gel.
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4. Under Display Options, you can select the following:

 Highlight saturated pixels — to display saturated pixels in red, which 

indicates how much of the gel image is saturated. You can change this 

option at any time by selecting View > Image Transform.

 Image color — to select a color scheme for displaying the sample image. 

Viewing the image in a different color scheme can make all of its elements 

more visible. See the chapter, Viewing Images, in the Image Lab Software 

User Guide for more information.

5. Save the protocol and run it or go to the analysis or output settings. 

To specify the scan area for custom size gels

1. Under Scan Coordinates, change the coordinate settings to increase or 

decrease the size of the scan area.

2. Save each coordinate setting when you change it. 

The Protocol screen displays the scan area with the coordinate values you 

select.

For more information about resetting scan coordinates, see Previewing the Gel 

in this chapter.
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Configuring Analysis Settings

To analyze a gel or blot automatically, configure analysis settings in the following 

protocol setup tasks:

 Detect Lanes and Bands

 Analyze Molecular Weight

For information about these settings, see the chapter, Protocols, in the Image Lab 

Software User Guide.

Configuring Output Settings

When you display a report, a scrollable report screen appears in which you can view 

the image, acquisition settings, and analysis data. You can view or print a single 

image or report.

Note: You cannot print a report on a thermal printer.

To specify protocol output

1. Select Specify Output in the left pane of the Protocol Setup screen.

 Output options appear in the right pane.
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2. Choose one of the following:

 Automatically print the image

 Automatically print a report

 Display the report

Image Lab prints to the default printer unless you select another printer. 

See the chapter, Generating Reports, in the Image Lab Software User Guide for 

information about customizing reports.

For more information about running a protocol, see the chapter, Protocols, in 

the Image Lab Software User Guide.

Positioning the Sample

To position a sample

1. Ensure that the sample area is clean and free of dust and other contaminants. 

Contamination can degrade the results.

2. Place the sample on the sample area.

3. Lower the lid.

For more information, see Cleaning the Imaging Surfaces on page 35.

Previewing the Gel

Preview the gel to ensure that the scan coordinates are set correctly.

To preview a gel

1. Open the protocol.

2. In the left pane, click Preview Gel.
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The densitometer scans the sample. As the scan progresses, Image Lab 

displays the scan in a scan area box outlined in red. 

3. If the scan area box does not include the sample or bands of interest, do one of 

the following:

 Click Cancel Run and reset the scan coordinates.

 Place the pointer in the scan box and drag the corners of the box to 

include the area that contains the sample or bands of interest. 
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4. Click Rescan Preview and then examine the rescanned sample.

5. When the preview is acceptable, click Run Protocol in the left pane.

All changes to preview scans are listed in the document log.

Running the Default Protocol

Save the default protocol and close the Profile Setup screen before you start the 

next procedure. 

To run a default protocol for one sample

1. Open the densitometer lid.

2. Place a sample on the sample area.

3. Close the lid.

4. Press the green Run button on the front of the densitometer. 
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The Default Protocol screen opens and the default protocol runs 

automatically.The acquired image appears with the Protocol Setup screen open 

behind it.

To run a default protocol for several samples

1. Open the densitometer lid.

2. Place a sample on the sample area.

3. Close the lid.

4. Press the green Run button on the front of the GS-900 densitometer. 

The Default Protocol screen opens and the default protocol runs automatically.

5. Save the image that appears.

6. Open the lid.
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7. Remove the sample and insert another sample.

8. Close the lid.

9. On the Protocol Summary screen, click the Run button.

10. Save the image.

11. Repeat steps 6–10 to run each remaining sample.

Running Any Other Protocol

Only the default protocol can be run by pressing the Run button on the 

densitometer. All other protocols are run from Image Lab Software, as described in 

the next procedure.

To run a protocol

1. Position the sample on the sample area of the densitometer. 

2. Close the lid.
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3. On the toolbar, click Open.

4. Browse to the protocol, select it, and click Open.

The Protocol Setup screen appears.

5. (Optional) If you are not certain that the scan coordinates are set correctly, click 

Preview Gel and evaluate the preview image.

6. Click Run Protocol in the left pane of the Protocol Setup screen.

After the protocol runs, the acquired image appears with the Protocol Setup screen 

open behind it.

Setting Up a Custom Application

When you create a protocol, Image Lab displays a list of application types and 

predefined applications for acquiring images. To use a dye or stain not listed in the 

Application dropdown menus, you can choose the application type Custom and 

create a custom application. Also choose Custom to do the following:
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 Choose a previously saved custom application

 Edit or rename a custom application

Note: If you are not sure how to configure a custom application for a dye or 

stain, contact Bio-Rad Technical Support.

To create a custom application

1. On the Protocol Setup screen, select Gel Imaging. 

2. Under Application, click Select and choose Custom on the menu that appears.

 The Manage Custom Applications dialog box appears. 

3. Click New.

The Create Custom Application dialog box appears.

4. Enter a unique application name and select a filter color, scan mode, and image 

color.

5. Selecting the filter color conveys information to the instrument that ensures 

proper imager acquisition. Choose one of the following scan modes:

 Transmissive — light from the top of the densitometer passes through the 

gel. Choose this option to scan gels or transparent objects such as X-rays 

or film.
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 Reflective — light from the bottom of the densitometer reflects off the gel. 

Choose this option to scan blots or opaque objects such as paper or 

photographs.

6. Click OK.

Editing a Protocol

You can open a protocol, change its settings, and save it with another name. You 

can also disable a step in the saved protocol. When you edit a default protocol and 

save it with a new name, the default protocol is unaffected. See the chapter, 

Protocols, in the Image Lab Software User Guide for more information.
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A Maintaining the GS-900 
Densitometer

Regular cleaning ensures that your GS-900™ calibrated densitometer will continue 

to perform optimally. This appendix explains proper care for the densitometer.

Caution: No user-serviceable parts are inside the densitometer. Refer servicing 

questions to Bio-Rad service personnel. 

Cleaning the Imaging Surfaces

During normal operation, residue can build up on the three glass areas:

 Sample area

 Calibration area (the narrow band of glass near the sample area)

 Transmission module on the lid

Use a nonabrasive, lint-free towelette and a 70% ethanol solution to clean the glass 

in these areas. Avoid using excessive liquid around the power switch and connector 

outlets located on the back side of the unit.

Note: Residual Coomassie stain on the sample and calibration areas can affect 

image data. The glass sample and calibration areas should be cleaned with a 

70% solution of ethanol until no remaining stain is seen on the towelette. 
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Recalibrating the GS-900 Densitometer

When you first connect the GS-900 densitometer to the computer on which 

Image Lab™ is running, the instrument automatically begins initial calibration. When 

the densitometer has been in use for some time, it might require recalibration for 

one of the following reasons:

 Scheduled recalibration according to your institution’s procedures

 Presence of visible artifacts such as a non-uniform background or streaks

Recalibrating the densitometer consists of three tasks:

 Preparing the instrument and Image Lab.

 Recalibrating standards locations, if necessary.

 Recalibrating flat field, if necessary.

You can recalibrate the standard locations or the flat field, or both.

To prepare for recalibrating the densitometer

1. Ensure that the sample glass, the glass on the transmission module, and the 

glass in the calibration area are clean and free of scratches.

2. Ensure that the lid on the densitometer is lowered.

3. Turn on the densitometer.

4. Connect the densitometer to the computer running Image Lab.

5. Start Image Lab on the computer.

6. On the Edit menu, click Instrument Setup.
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The Instrument Setup dialog box appears. 

To recalibrate standard locations

1. Under Calibration Standard Locations, click Reset.

The Calibrate GS-900 Standard Location dialog box appears.

2. Click Calibrate GS-900 Standard Locations.

Calibration begins. A progress box monitors its progress. When calibration 

ends, the Setup Summary dialog box appears.
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3. Check the Status entry to ensure that the calibration is valid.

4. Click Finish.

The Instrument Setup dialog box reappears. 

To recalibrate flat field

Note: Acquiring flat images can take up to 30 minutes.

1. In the Instrument Setup dialog box, Under Flat Field click Reset.

The Acquire Flat Image dialog box appears.

2. Click Acquire Flat Image.

A progress box monitors the calibration.

3. When calibration ends, the Setup Summary dialog box appears.

4. Check the Status entry to ensure that the calibration is valid.

5. Click Finish.

6. When the Instrument Setup dialog box appears, click OK.
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Next Steps

If the standard locations or flat field recalibration fails, clean the sample glass and 

the glass on the transmission module and recalibrate again. If recalibration fails 

again, contact Bio-Rad Technical Support.

Recertifying the Calibration Standard

The internal transmissive calibration standard is certified to an NIST-traceable 

standard for two years. Two years after the last certification date of the internal 

transmissive calibration standard, a Bio-Rad service engineer must recertify or 

replace it. Two months before this date, Image Lab displays a message to this effect 

similar to the following:

A second message appears on the date the certification expires. In Image Lab on 

the Edit menu, click Instrument Setup to access the Instrument Setup screen and 

verify the expiration date. Contact Bio-Rad technical support to replace or recertify 

the calibration standard.

For more information about the internal calibration standards, see Measurement of 

Optical Density on page 12.
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B Troubleshooting

Follow these suggestions to troubleshoot your GS-900™ densitometer.

Problem Possible Cause Solution

Instrument does not 

scan and makes a 

loud clicking noise 

during attempted 

scan or during startup 

initialization.

Upper or lower carriage 

locking mechanisms are still 

locked.

Unlock carriage locking mechanisms.

Instrument fails to 

perform a scan and 

Image Lab reports 

that debris is on the 

imaging area.

Water or foreign matter is on 

the calibration area of the 

instrument.

Clean the calibration area and ensure 

that water drops are wiped up when 

transferring gels to the sample area. 

For more information, see Cleaning 

the Imaging Surfaces on page 35.

Streaks or other dark 

or light regions appear 

in the image (most 

apparent when the 

entire sample area is 

scanned and the 

resulting image is 

transformed to 

emphasize faint 

signal.)

Contamination or foreign 

object is on calibration or 

sample area. 

Reset Flat Field calibration. For more 

information, see Recalibrating the 

GS-900 Densitometer on page 36.

Note: Coomassie stain might build 

up during normal use. It is 

recommended that the calibration 

and sample area be thoroughly 

cleaned with 70% ethanol on a 

regular basis.
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C Accessories

Ordering Information

Table 3 lists catalog numbers and descriptions for the GS-900TM densitometer and 

Image LabTM software. For more information, see the Bio-Rad catalog.

1707991 GS-900 Calibrated Densitometry System with Image Lab software 

1709690 Image Lab software, Windows

1709691 Image Lab software, Security Edition, Windows

Table 3. Ordering information 
Catalog # Description

Image Lab Software



C  |  Accessories

44  |  GS-900 Calibrated Densitometer with Image Lab Software 





10000076954 Ver A     US/EG 17-0338    0217    Sig 1216

Web site bio-rad.com  USA 1 800 424 6723  Australia 61 2 9914 2800  Austria 43 1 877 89 01 177  Belgium 32 (0)3 710 53 00  Brazil 55 11 3065 7550  
Canada 1 905 364 3435  China 86 21 6169 8500  Czech Republic 420 241 430 532  Denmark 45 44 52 10 00  Finland 358 09 804 22 00  
France 33 01 47 95 69 65  Germany 49 89 31 884 0  Hong Kong 852 2789 3300  Hungary 36 1 459 6100  India 91 124 4029300  
Israel 972 03 963 6050  Italy 39 02 216091  Japan 81 3 6361 7000  Korea 82 2 3473 4460  Mexico 52 555 488 7670  The Netherlands 31 (0)318 540 666  
New Zealand 64 9 415 2280  Norway 47 23 38 41 30  Poland 48 22 331 99 99  Portugal 351 21 472 7700  Russia 7 495 721 14 04  
Singapore 65 6415 3188  South Africa 27 (0) 861 246 723  Spain 34 91 590 5200  Sweden 46 08 555 12700  Switzerland 41 026 674 55 05  
Taiwan 886 2 2578 7189  Thailand 66 2 651 8311 United Arab Emirates 971 4 8187300  United Kingdom 44 020 8328 2000 

Bio-Rad 
Laboratories, Inc.

Life Science
Group


	Table of Contents
	Safety and Regulatory Compliance
	Important Safety Information
	Warranty
	General Precautions
	Regulatory Notices
	Alert Icons
	Cautions
	Warnings

	Instrument Safety Warnings
	Notice


	1 Introduction
	Main Features of the GS-900 Calibrated Densitometer
	Measurement of Optical Density
	Technical Specifications

	2 Setting Up the Imager
	Calibrating the GS-900 Densitometer

	3 Acquiring Images
	Creating a Protocol
	Accessing Protocol Setup Screens
	Choosing an Application
	Configuring Analysis Settings
	Configuring Output Settings
	Positioning the Sample
	Previewing the Gel

	Running the Default Protocol
	Running Any Other Protocol
	Setting Up a Custom Application
	Editing a Protocol

	A Maintaining the GS-900 Densitometer
	Cleaning the Imaging Surfaces
	Recalibrating the GS-900 Densitometer
	Next Steps

	Recertifying the Calibration Standard

	B Troubleshooting
	C Accessories
	Ordering Information


